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修订历史
产品版本 操作手册 变更内容 说明
2.09.xx BA00065S/04/EN/

01.12
– 原版操作手册

2.09.xx BA00065S/04/EN/
02.13

新增 WirelessHART，NI 卡，FFusb 调制解调器；MACTek 蓝牙
调制解调器，安装 DTM，更新 DTM 目录，更换 iDTM

编辑 在 Windows 7 中安装 USB 的步骤
布局 新 CD 光盘

2.10.xx BA00065S/04/EN/
03.15

布局 新 CMS
新增 HART（通过 Rockwell Automation ControlLogix），

PROFIBUS PA（通过 Rockwell Automation ControlLogix
区段），用户角色，检查网络

2.10.xx BA00065S/04/EN/
04.15

新章节和变更 HART（通过 RSG、Fieldgate SFG500 和 Siemens
ET200M/iSP），PROFIBUS DP（通过 PROFIBUS 调制解调
器和 WAGO 远程输入/输出），PROFIBUS DP（通过
PROCENTEC ProfiCore），工厂视图，SFG500 故障信息

2.11.xx BA00065S/04/EN/
05.16

新章节和变更 关于 FieldCare、Pepperl+Fuchs LB/FB 远程输入/输出、
HIMA、PROFINET - PROFIBUS 网关、PBI-PLUS、心跳校
验、I/O Link 网络以及 W@M 接口的介绍

2.11.xx BA00065S/04/EN/
06.17

文档资料分为
操作手册和特
殊文档

《FieldCare 项目教程》SD01928S

2.12.xx BA00065S/04/EN/
07.17

新产品版本
“操作”章节变
更

-

2.13.xx BA00065S/04/EN/
08.18

新产品版本 -

2.13.xx BA00065S/04/EN/
09.18

变更 删除 I/O-Link 主题

2.14.xx BA00065S/04/EN/
10.19

新产品版本 IO-Link

2.15.xx BA00065S/04/EN/
11.20

新产品版本 • 以 U 盘取代 DVD 光盘
• 软件许可证管理（SLM）

2.17.xx BA00065S/04/EN/
12.22

新产品版本 • FDI 程序包支持
• 安全更新

2.18.xx BA00065S/04/EN/
13.23

新产品版本 • Windows 11 支持
• Microsoft SQL Server 2022 Express
• FDI 程序包更新支持，针对 Endress+Hauser 和第三方制

造商
• 更新 PROFINET CommDTM
• 更新 CDI CommDTM
• 更新流量校验 DTM
• 组件安全更新
• 《安全手册》SD03193S
• 目录更新，改进 B&R 扫描和 IO-Link 通信
• 移除 W@M 功能，原因是 W@M 门户网站已于 2023 年

12 月 31 日关闭
2.19.xx BA00065S/04/EN/

14.24
新产品版本 • 更新 FXA291 驱动程序

• 更新 Softing PROFIdtm
• 更新校验 DTM
• 更新 PROFINET CommDTM
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1  文档信息

1.1  文档功能
《操作手册》包含软件使用所需的所有信息：从产品描述、安装和使用，至系统集成、
操作、诊断和故障排除，以及软件更新和废弃。

1.2  信息图标

1.2.1  安全图标
!"

危险状况警示图标。若未能避免这种状况，会导致人员严重或致命伤害。
!"

危险状况警示图标。若未能避免这种状况，可能导致人员严重或致命伤害。
!"

危险状况警示图标。若未能避免这种状况，会导致人员轻微或中等伤害。
!"

操作和其他影响提示信息图标。不会导致人员伤害。

1.2.2  特定信息图标

图标 说明
允许
允许的操作、过程或动作。
推荐
推荐的操作、过程或动作。
禁止
禁止的操作、过程或动作。
提示
附加信息。
参考文档

A 参考页面

参考图

提示信息或重要分步操作

1. 、 2. 、 3.… 操作步骤
操作结果

帮助信息

外观检查
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1.2.3  FieldCare 图标

图标 说明
开始新项目。

打开现有项目。

保存打开的项目。

打印打开的项目。

打开剪贴板。

显示 DTM 目录。

打开选定设备的文档资料或详细设备信息。

打开详细目录。

激活协议。

向网络添加新设备。

删除网络中的设备。

用 CommDTM 和 DeviceDTMs 创建新网络拓扑结构。

将字段中的网络拓扑结构与实际的物理网络进行比较，并将设备添加到现有网络中。

扫描预配置拓扑结构，显示含扫描设备信息的报告。

显示是否与设备连接。

将信息从设备传输到 FieldCare。

将信息从 FieldCare 传输到设备。

所选设备的设备特定功能。

添加工厂层级。

添加项目。

删除工厂层级。

删除项目。

打开设备检查表，显示工厂中的所选设备。

确认更换的设备。

断开连接。 1)

建立通信，通信准备就绪 1)
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图标 说明
通信通道已被占用或通信操作已取消。 1)

已连接 1)

打开触摸模式

关闭触摸模式

1) 状态指示器：工厂和网络视图中的设备在线/离线状态指示

1.3  文本强调
强调 说明 实例
加粗 按键、按钮、程序图标、选项卡、菜单、命令 Start → Programs → Endress+Hauser

选择 File 菜单中的 Print 选项。

1.4  使用的首字母缩略词
首字母缩略词 说明
APL 高级物理层
CSV 逗号分隔值
DTM 设备类型管理器（设备驱动程序）
FDI 现场设备集成
FDT 现场设备工具
HART 可寻址远程传感器高速通道
I/O 输入/输出
IO-Link 包含智能传感器和执行器的通信系统品牌名称
IODD 电子设备说明（IO 设备说明）
IP 互联网协议
PROFIBUS 过程现场总线
PROFINET 过程现场网络
SLM 软件许可证管理
TCP 传输控制协议
UDP 用户数据报协议
URL 统一资源定位符

1.5  文档资料
FieldCare SFE500
• 《入门指南》KA01303S
• 《FieldCare 项目教程》SD01928S
• 《技术资料》TI00028S
• 《安全手册》SD03193S
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1.6  注册商标
PROFINET®是 PROFIBUS 用户组织（PNO）（德国卡尔斯鲁厄）的注册商标。
PROFIBUS®是 PROFIBUS 用户组织（PNO）（德国卡尔斯鲁厄）的注册商标。
IO-Link®是 IO-Link 组织和 PROFIBUS 用户组织（PNO）（德国卡尔斯鲁厄）的注册商
标。
FOUNDATIONTM Fieldbus 是现场通信组织（美国得克萨斯州奥斯汀市，TX 78759）的
注册商标。
HART®、WirelessHART®是现场通信组织（美国得克萨斯州奥斯汀市，TX 78759）的注
册商标。
Ethernet/IP 是 ODVA（美国密歇根州）的注册商标。
Modbus®是 Modbus 组织（美国霍普金顿）的注册商标。
所有其他品牌和产品名称均为相关公司和组织的商标或注册商标。
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2  基本安全指南

2.1  人员要求
仅限经授权的团体以实际和电子方式访问现场设备、网络、计算机和系统。因此，必须
使用基于角色的访问系统。建立详细的指南和程序，只允许授权人员访问计算机或其他
设备。

2.2  指定用途
FieldCare 是基于 FDT（现场设备工具）的工厂资产管理软件，可用于设备参数设置、仪
表管理或状态监控（取决于具体型号）。通过使用适当的设备类型管理器（DTM），能
够操作现场设备和系统组件，而不受通信协议影响。
必须使用正确设置的防火墙，拦截不符合安全规范的所有数据。为了进一步提高安全
性，必须禁用未使用的端口，且必须使用隔离区或入侵检测系统。所有产品必须采取有
序及时的补丁管理程序，例如操作系统、网络浏览器、程序、应用程序、数据库和驱动
程序。同样，计算机必须安装反病毒软件。只能使用由可信来源提供的硬件、软件、固
件和其他电子内容。
以电子方式访问计算机、FieldCare、SQL 服务器及现场设备等的程序时，建议使用安全
密码：
• 密码必须包含至少 8 个字符
• 不得使用用户名、姓名或公司名称
• 不得包含一个完整单词
• 必须与以前使用的密码有明显不同
• 必须由大写字母、小写字母、数字和符号组成
• 必须定期更改

详细安全信息参见《安全手册》SD03193S（www.endress.com/SFE500）

2.3  产品安全
DEP - 数据执行保护
DEP 是一个安全工具，可帮助计算机预防病毒、损害和安全威胁。通过监控程序，DEP
可帮助保护计算机，并确保应用程序安全使用系统内存。一旦应用程序试图访问某个程
序，DEP 就会关闭该程序。

配置 DEP
1. 点击 Windows key → Pause key → Advanced system settings → Advanced。
2. 按照提示输入管理员密码。
3. 选择 Performance → Settings。
4. 点击 Data Execution Prevention 选项卡，然后选择 Turn on DEP for All

Programs and Services。如果程序不在列表中，点击 Add，选择程序并点击
Open。

5. 点击 OK。
 “System properties”对话框打开。

6. 点击 OK。
7. 重新启动计算机以激活更改内容。

编号 说明 状态
0 始终关闭 为所有进程关闭 DEP。
1 始终打开 为所有进程打开 DEP。
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编号 说明 状态
2 选择启用 为主要 Windows 程序和服务打开 DEP，默认设置。
3 选择退出 除程序和服务外，DEP 可用于所有进程。

技术改进
Endress+Hauser 保留随时对软件和设备进行技术改进的权利，恕不另行通知。如果此类
改进不影响软件的操作，则不会记录在案。如果改进影响到操作，则创建并发布新版本
操作手册。

2.4  IT 安全
我们只对按照《操作手册》安装和使用的产品提供质保。产品自带安全保护功能，防止
意外更改设置。
IT 安全措施为产品及相应数据传输提供额外保护，必须操作员本人按照安全标准操作。
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3  产品描述

3.1  软件功能
《操作手册》介绍如何使用 FieldCare，通过调制解调器、网关和远程输入/输出建立与
HART、PROFIBUS、FOUNDATION Fieldbus、Modbus、IO-Link 和 EtherNet/IP 设备的
连接。

3.1.1  软件许可证管理（SLM）
有关“软件许可证管理（SLM）”的详细信息：入门指南 →   6

3.1.2  用户角色
安装 FieldCare 后，用户登陆最初被禁用，以便在无需登陆的情况下启动
FieldCare。

激活用户登陆
1. 打开 FieldCare Administrator →   14。
2.

必须选择 User and User Groups → Configuration，并激活 User Login active。

用户角色
提供不同用户角色。每个用户可使用为其分配的特定角色登陆。用户获得特定功能的授
权。确保只有授权用户才能访问技术和操作特点。此外，可以定义在指定期限内有效的
权限。

• 创建任意数量的用户
• 为用户帐户分配可选设置
• 进行可选设置后更改密码
• 用户可更改密码
• 用户密码在指定期限内有效
• 如需要，禁用用户帐户
• 根据 FDT 标准为用户分配角色

用户角色 权限
管理员 访问不受限制，可执行所有功能，例如 FieldCare 中的开发、调试和运行阶段。

管理任务，例如分配用户帐户。
更改或更新 DTM 目录。

规划工程师 访问不受限制，可执行所有功能，例如 FieldCare 中的开发、调试和运行阶段。
维护工程师 执行授权的调试和运行阶段。

更换、标定和调整设备。
向设备写入参数，更改或读取参数。
在在线模式下执行特定设备操作。

用户 执行授权的调试和运行阶段。
观察和管理当前过程。
检查设备当前状态。
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用户角色 权限
更改设置点，确保设备正常运行。

观察员 观察和管理当前过程。
读取设备参数和连接设备的文件。

3.2  应用领域
FieldCare 是设置和管理智能现场设备的通用工具。可以轻松进行设备组态设置、维护管
理、基于状态的维护和工厂资产管理。根据许可证的不同，可以适应不同需求，因此可
以随时升级。
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4  安装
关于“安装”的详细信息：入门指南→   6
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5  操作

5.1  启动 FieldCare
‣

打开 FieldCare。
 FieldCare 打开。

5.2  在 FieldCare 中设置
1. 启动 FieldCare→   13。
2. 关闭“FieldCare”对话框。
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3. 单击 Extras → Options。
 打开“Options”对话框。

4. 进行必要调整，例如语言。
5. 单击确定保存更改。

5.3  在 FieldCare 管理中设置
在打开 FieldCare Administration 之前关闭 FieldCare。
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1.

打开 FieldCare Administration。
 “FieldCare Administrator Login”对话框打开。

2. 输入用户名 Administrator 和密码 Admin，并单击 Login。
 “FieldCare admin”对话框打开。

3. 在窗口左栏中选择所需菜单，例如 Users。
4. 打开文本菜单并执行所需设置。
5. 保存更改。
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5.4  用户界面

 1 FieldCare 主对话框
1 工厂视图
2 网络视图
3 菜单栏
4 工具栏
5 DTM/参数视图
6 可选对话框
7 状态栏

5.5  常规设置

5.5.1  项目设置
1. 在 FieldCare 中，单击 Extras → Options。
2. 单击 Project 选项卡。

 显示“Project”选项卡。

3. 选择 Prompt for project at start-up 并单击 OK。
 每次启动程序时都会显示项目对话框。
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5.5.2  扫描设置
1. 在 FieldCare 中，单击 Extras → Options。
2. 单击 Scanning 选项卡。

 显示“Scanning”选项卡。

3. 选择 Connect after scanning if only one device is found and automatically open
the DTM in the Online window 旁边的复选框，并单击 OK。

建立网络后即显示扫描结果。
扫描后，如果 FieldCare 只找到一台设备，则与 DTM 自动建立连接并在线切换。如
果找到多台设备，必须分别连接每个 DTM。根据 DTM 的情况，双击未连接的设备
也会显示连接提示。否则，必须使用“Connect”选项。《操作手册》中未介绍具体设
备的组态设置。相关信息参见相应设备的《操作手册》。
默认情况下，FieldCare 通过 FDT 1.2 接口执行扫描。如果已启用“Pefer FDT 1.2.1
scan”选项，可将其用作备选项。
FDT 1.2.1 通过自身的 Comm/Gateway DTM 进行扫描时，在速度方面具有优势。

5.5.3  工厂视图
更改网络视图时，工厂视图自动同步。手动更改工厂视图不会影响网络视图。因
此，可以独立于网络拓扑结构设计工厂。

添加一个新层级
1. 右键单击一个项目。
2. 单击 Plant View → Add Plant Level。

 可选择一个新工厂层级。
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 2 工厂视图结构

工厂层级 说明
企业 在最高层级 0 中仅创建一个此类型条目。
系统
范围
过程单元
单元

在层级 1 中创建。

范围
过程单元
单元

在“Site”类型下创建。

过程单元
单元

在“Area”类型下创建。

单元 在“Process cell”类型下创建。
分析设备
数字设备
压力测量仪表
特殊
流量计
液位变送器
温度测量仪表
阀门
未知设备

在“Unit”类型下创建。

项目 随后用 Change software 变更项目。

 无法再对所有其他类型进行回顾性操作。在这种情况下，必须删除该类型并创建一个新
类型。

 可以通过 Assign 功能将条目逻辑性地链接到网络视图中的设备。用 Unassign Device 删除链接。
随后可以修改所有条目的标题文本。
可以通过文本菜单为每个条目输入说明，或将每个条目链接到文件或网站 URL。

创建工厂视图前，必须先创建网络视图。工厂视图对应于实际工厂拓扑结构；技术视图
采用层级方式显示生产过程。具有“规划工程师”或更高级别角色的用户可以创建新的工
厂视图或修改现有视图。
项目可以在工厂视图中切换。工厂视图中的元素可以重命名、添加或删除。

列 用途
工厂标签 每个工厂位置的工厂标签。
接线 指示在线/离线状态的符号。
状态 指示当前诊断状态。
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列 用途
监控 通过状态监控启用对当前设备的监控的选项。
关键 指定该设备是否是关键设备的选项。
通道 指示设备连接的通道。
地址 指示分配给此工厂位置的设备的地址。
设备型号（DTM） 指示设备型号。
实体设备 标识网络中特定点的实体设备。

5.5.4  网络视图
网络视图以图形显示属于 FieldCare 项目的设备网络。

列 用途
网络标签 设备的网络标签。
接线 指示在线/离线状态的符号。
通道 指示设备连接的通道。
地址 设备的唯一网络地址。
设备型号（DTM） 指示每个设备的型号。
实体设备 标识网络中特定点的实体设备。

5.6  常规功能
工厂/网络视图
• 通过 Context menu/上下文菜单 → Customize Plant View/自定义工厂视图
• 显示对话
• 显示/隐藏列
• 调整列顺序
列表功能选项
• 进行调整，根据列标题对列表进行排序
• 更改列宽
• 使用“Copy/复制”和“Paste/粘贴”更改列顺序

5.7  验证网络
可以将 FieldCare 中的网络拓扑结构与实际的物理网络进行比较。对于将设备添加到现
有网络中，这特别有用。项目可以在离线状态下准备，然后通过 FieldCare 上传。这样
可以验证网络中的当前拓扑结构和物理拓扑结构，以进行必要的更改。

在验证网络之前，请注意只有经过验证的网络才可针对至少具有一个 DTM 的通信
设备进行验证。否则将禁用 Verify Network/验证网络菜单项。

验证网络
1. 在网络视图中，选择至少具有一个 DTM 的设备。
2. 单击工具栏中的 Verify network/验证网络 。

 显示“Communication channel/通信通道”对话框。
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3. 选择所需通道并单击 OK/确定。
 FieldCare 扫描所需的通道。

一旦验证了网络，就会显示“Scanning Result/扫描结果”对话框。
显示一个当前列表，Status/状态列指示预规划拓扑结构中的设备与实际拓扑结
构的匹配程度。
共有五种不同状态：
设备型号和序列号相同。
设备型号相同。
设备型号不同。
发现一台新设备。
项目中的意外设备。

4. 可以在相关设备的文本菜单中进行更改。读取/写入设备数据或更改设备型号。
单击 OK/确定确认更改。
 保存更改。
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6  系统集成

6.1  设置 IP 地址
• 需要管理员权限
• 该说明适用于 Windows 7

所有带以太网接口的 Endress+Hauser 设备都有一个默认 IP 地址，例如 Fieldgate
FXA720 的 IP 地址是 192.168.253.1。要使主机能够与 Fieldgate FXA720 以太网服务器
通信，必须在相同的地址域中分配一个 IP 地址，例如 192.168.253.99。如需更多信
息，请与网络管理员联系。

设定计算机 IP 地址
1. 单击 Start/开始 → Control Panel/控制面板 → Network and Internet/网络与互联

网 → Network and Sharing Center/网络与共享中心。
 显示“Network connections/网络连接”对话框。

2. 单击 Manage Network Connections/管理网络连接。
3. 右键单击要更改的 connections/连接。
4. 根据要求：

输入 Administrator password or confirmation/管理员密码或确认。
5. 右键单击 Network/网络选项卡。
6. 单击“This connection uses the following items/此连接使用以下项目”条目中的

Internet Protocol Version 4 (TCP/IPv4)。
7. 单击 Properties/属性。
8. 记录计算机 IP 地址和子网掩码的原始值，如有必要，在操作结束时恢复这些值。

在公司网络中使用的计算机将自动获得网络地址。
单击 Use the following IP addresses/使用以下 IP 地址。

9. 输入“TCP/IPv4”的 IP address, subnet mask and default gateway/IP 地址、子网
掩码和默认网关。
 已接受 IP 地址设置。

10. 单击 OK/确定。
 程序已完成。

6.2  Windows 防火墙
如果服务器所在的计算机和客户机使用了防火墙，则必须对防火墙进行编程以允许
相互访问。由于防火墙配置通常属于公司 IT 安全策略问题，在继续之前应咨询系统
管理员。此外，执行此任务需要管理权限。

下表列出了适用于 Fieldgate SFG500 的端口：
端口号 ID
TCP 60010 TCP_PCPS2_SFG500_PORT
UDP 60015 UDP_IDENTIFY_PORT
UDP 60020 UDP_ANNUNC_PORT

管理 Windows 防火墙
1. 按下 Start/开始 → Control Panel/控制面板 → Windows Firewall/Windows 防火

墙。
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2. 单击左侧窗格中的 Allow a program or feature through Windows Firewall/允许
程序或功能通过 Windows 防火墙。

3. 根据要求：
输入 Administrator password/管理员密码。

4. 选中程序旁边应该允许的复选框，然后单击 OK/确定。
5. 单击左侧窗格中的 Advanced Settings/高级设置。
6. 根据要求：

输入 Administrator password/管理员密码。
7. 在“Windows Firewall with Advanced Security/Windows 防火墙与高级安全”对话框

中，单击 Inbound Rules/入站规则。
8. 单击左侧窗格中的 New Rule/新规则。
9. 遵循新入站规则向导中的说明。

10. 切换到 Exceptions tab/例外设置选项卡。
 显示两个主要层级。可以在这些层级上添加例外设置。

“Add Program/添加程序”指定哪些应用程序能够响应自发询问。
“Add Port/添加端口”指定防火墙应允许服务器使用的端口处的 TCP 流量。

11. 在“General/通用”选项卡上，勾选 On (recommended) /开启（推荐）复选框。
防火墙现在处于活动状态。



FieldCare SFE500 操作

Endress+Hauser 23

7  操作
根据项目存储模式，项目相关数据保存在数据库或文件中。

7.1  设置显示语言
1. 打开 FieldCare。
2. 必须选择 Extras → Options。

 打开“Options”对话框。

3. 在 Display 选项卡中选择语言，然后单击 OK。
 该语言将被保存，并在下次程序启动时提供。

7.2  创建项目
创建项目的初始步骤始终相同。默认情况下将显示一个 FieldCare 对话框，可以禁
用此对话框：Extras → Options → Project。如果已勾选 None 复选框，将不会显示
FieldCare 对话框。
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创建项目
1. 打开 FieldCare。

 打开“FieldCare”对话框。

2. 在“New”选项卡中选择 Create Project 条目，然后单击 Open。
 FieldCare 通过主机打开一个新项目。

7.3  保存项目
FieldCare 项目存储在数据库中，但不能作为硬盘上的文件访问。在文件模式下，可
以通过使用 FieldCare 访问这些文件。所有项目以相同方式保存。

保存项目
1. 必须选择 File → Save As。

 打开 Save Project As 对话框。

2. 输入项目名称并单击 Save。
 项目已保存。
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7.4  打开保存的项目
打开保存的项目
1. 在 FieldCare 对话框中单击 Existing 选项卡。

 显示“Open Project”对话框，其中包含上次打开的项目。

2. 选择所需的项目，然后单击 Open。
 显示项目。

如果项目没有出现在屏幕上，单击 View→ Network。

7.5  CSV 导出和导入
工厂和网络视图（工厂/网络拓扑结构）的结构信息可以导出到 CSV 文件，也可以从
CSV 文件导入 FieldCare 项目。

导入 CSV 文件
1. 创建一个项目。→   23
2. 单击 File/文件 → Import/Export/导入/导出 → Import CSV file/导入 CSV 文件。

 显示“Import CSV file/导入 CSV 文件”对话框。
3. 选择一个文件并单击 Open/打开。

 CSV 文件中的数据被导入工厂视图和/或网络视图。

导出 CSV 文件
1. 选择一个项目。
2. 单击 File/文件 → Import/Export/导入/导出 → Export CSV file/导出 CSV 文件。

 显示“Exported topology/导出的拓扑结构”对话框。
3. 单击 Export/导出。
4. 选择一个储存位置和一个名称，然后单击 Save/保存。

 网络视图导出到 CSV 文件中。

7.6  DTM 信息
Information 对话框包含所有相关 DTM 信息概览。

显示 DTM 信息
1. 单击菜单栏上的 Device Catalog。
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2. 单击 View。
 打开设备目录。

3. 右键单击 DTM。
4. 单击 DTM Information。

 “Information”对话框打开。

“Information”对话框中的可能选项
• 显示 DTM 支持的所有设备型号的基本信息
• 显示 DTM 信息：

• 制造商 ID
• 设备类型 ID
• 子设备类型 ID
• 设备类型信息

7.7  显示设备目录
Device catalog 对话包含当前设备管理系统中所有 DTM 和 FDI 程序包的列表。DTM 可
按类别、制造商或协议进行分组。

1. 单击菜单栏中的 Device catalog。
2. 单击 Display。

 打开设备目录。

7.8  更新设备目录
关于 Updating the device catalog 的详细信息：入门指南→   6
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8  诊断和故障排除

8.1  常规故障排除
问题 故障排除
FieldCare SQL 服务器
启动失败。

手动启动 SQL 服务器：
• 启动 Windows 并在搜索栏中输入 services.msc。
• 选择 SQL Server (SQLFIELDCARE)。
• 单击 Start。

扫描宏丢失。 导入宏：
• 在文件夹“...\Endress+Hauser\FieldCare\db”中，导入文件

ImportScanningMacros.cmd。
• 然后重新启动 FieldCare。

重复的菜单项或窗口丢
失。

重置布局：
• 关闭 FieldCare。
• 在“...\Endress+Hauser\FieldCare\Profiles”文件夹中，删除文件 profile.xml。

设备故障目录。 复位 FieldCare 设备目录：
• 关闭 FieldCare。
• 在“...\Endress+Hauser\FieldCare\Frame”文件夹中，删除文件

FRMRepository.xml。
• 重新启动 FieldCare 并更新设备目录。

如有其他问题，请联系 Endress+Hauser 当地销售中心：
www.addresses.endress.com



软件更新 FieldCare SFE500

28 Endress+Hauser

9  软件更新
关于“更新软件”的详细信息：入门指南 →   6
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